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1 Introduction

Sigmiraa isa Software Defined Radio (SDR) application program that runs on Windows. It
operates with the RFSpace SDR-1Qa and SDR-14& receivers or with an external conventional
receiver. Sigmira offers wideband spectrograph and waterfall displays. It also demodulates
various "Ham" radio and military signals.

Its features include:
"Waterfall" and spectrograph displays of up to 200 kHz width with the SDR-1Q& and
SDR-144 .
Demodulation of PSK31, FSK, SITOR-B, CW, and NFM modes.
Demodulation of NATO STANAG 4285.
Demodulation of the "Japanese Navy Slot Machine" to QPSK symbols.
Point and click signal selection/tuning.
Signal database with automated tuning and logging.
Playback of saved .wav files.
Phase plane display.
16 bit sampling. Typical sampling rate: 48 ksps.
Signal strength meter.
Adjustable squelch.
Clock display with UTC and local time.

The distribution package includes examples of PSK31, RTTY, SITOR-B, CW, NFM, JSM and
STANAG 4285 signasin .wav files.

http://www.saharl ow.com/technology/sigmira

Sigmirais Copyright 2009 by Steven A. Harlow.

2 Program Installation

If you aready have Spectravue installed and working then the necessary drivers are already in
place for the SDR-1Qa and SDR-144 .

If you are about to start the SDR-1Q/14 for the first time, install Sigtoolsfirst. That way the
necessary drivers will be available when Windows asks for them.

Sigmiraisdistributed in the executable self-installer 'sigtools_1r8_installer.exe’. To install
Sigmirasimply run the installer.

(On some machines a pop-up window will appear asking if a.bat script should be allowed to run.
If that happens click 'Allow' and see section 8 - Program Installation Details.)

Copyright 2009, Steven A. Harlow 4
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Connect the SDR-1Q& to your PC with the USB cable. If Windows asks for adriver for the
device tell it to find the drivers in the <sigtools install root>/drivers. (The drivers are from Future
Technology Devices International, Ltd. [FTDI] and are also available from their web site.
hitp://www.ftdichip.com/Drivers/V CP.htm )

The nicer features of Sigmira are available when it is used with the SDR-1Qa .

Instructions on connecting a conventional radio receiver are given in section 6. Connecting a
receiver is not necessary in order to use Sigmirawith .wav files. See section 7.

3 Controls and Displays

3.1 Waterfall Display

The waterfall display displays atime history of the signal spectrum. It isalso used to select which
signal to demodulate.

The waterfall display is the bottom third of the window. Higher frequency components are
displayed to theright. The strengths of the frequency components are represented by
brightness/color. The display shifts down with time so that the most recent signal content is
displayed upper most. The display has a frequency scale along the top and atime scale along the
left edge.

- 40000 ;
i ﬁ'l"l: FE) SR

Figure 1 - Waterfall Display
The frequency scaleisin Hz and isrelative to the center tuning frequency. The frequency span of
the waterfall display is adjustable with the " Spectrum” "Width" controls. There are also controls
to pause the waterfall and to adjust the scaling of the display intensity level.

The scroll rate is adjustable. Move the cursor into the time scale on the left and roll the mouse
whesl.

Copyright 2009, Steven A. Harlow 5
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The waterfall display is aso used to select which signal to demodulate. RTTY, PSK31, and CW
are all narrow band transmissions. They show as bright vertical bands in the waterfall display.
PSK 31 and CW transmissions show as single vertical bands. A RTTY transmission showsas a
pair of vertical bands. Multiple transmissions may be present on the input and in the waterfall
display at one time.

Select the particular transmission to be demodulated by right-clicking on it in the waterfall
display.

A little red triangular pointer in the frequency scale indicates the frequency selected for
demodulation of the signal. When the 'Lock Center' option is off the select frequency is shifted to
the center of the display. When the 'Lock Center' option is on the display center frequency does
not change and the red triangle moves to the selected frequency.

When in PSK31 or CW mode right-click directly on the signal. When in RTTY mode two
triangles are shown on the frequency scale. Thetriangleto theright isred and corresponds with
the 'Mark' frequency. Right-click on the higher frequency column of the desired signdl, i.e. the
mark frequency. (It iseasier to click on asignal when the displayed spectrum width is narrower.)

With the sound card or wave file selected as the source the maximum waterfall width is 10 kHz.

3.2 Spectrum Display

The spectrum display displays a plot of signal level vs. frequency.

pr— ——

if:}—::-_jl o I—_;Eil:]i_::ljgljll_jl e ;'!E.]':_li_jlljgljll_jl e |-4|,|!‘:|__i17|_" e I—'.3|:|!::|:_i[||j" o I'ZIIII A ;:;'-'I;II!IEI_EII L ;-{'i:IIZ!l:Il_IIII L I__II::|L||_jI?I_I__[:I o I._:EII:II:_EIIII_I?:[:.
Figure 2 - Spectrum Display
Thereisasignal power scale at the |eft of the display. When SDR-IQ is selected as the source the

scaleisin dBm at the antennainput. When the source is the sound card or awave filethe scaleis
in dB relative to the full scale internal sample representation.

Tuning/frequency selection can be accomplished by right-clicking on the spectrum display just as
on the waterfall display.

The base level of the display can be adjusted with the Spectrum Base controls described in section
3.7.2. The base level can aso be adjusted by rolling the mouse wheel while the cursor isin the

spectrum display.

Copyright 2009, Steven A. Harlow 6
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3.3 Rx Text Display

The received text display pops up whenever one of the RTTY, PSK31, CW, or $4285 mode
buttonsis clicked.

||I||

W Ll'-ll J lll ﬂlll:h_ ) u u h! u-k- L L e
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RE PEAKIMG AM 5 & QN THE METER. , & FEW

3 UMITS ABOWE THE MOISE; I HAWE TEH ORICONS If: BANDWIDTH CRAMKED
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Figure 3 - Rx Text Window

The demodul ated text of the selected transmission appears here. (RTTY, PSK31, and CW
transmissions all originate as text type messages.)

Received text can be saved by following the File=>Save or File=>Save As menu dialogs.
Thetext display can be cleared by selecting the Edit=>Clear Text menu item.
Whenever the demodulation mode is changed or the frequency is changed by 100 Hz or more a

note is displayed in the Rx Text window.

3.3.1 File->Save/Save As

Selecting Save or Save As brings up adialog window that can be used to save the received
demodulated text to a windows text file. The entire text from the Rx Text window is saved to the
file. The default name of the destination text file at start-up is 'untitled’. The name can be
changed with the 'Save As selection. Sigmiraremembers any such change to the destination file
name. Subsequent 'Save' selections will write to the remembered destination file name. Any save
to afile overwrites the previous contentsif any.

Copyright 2009, Steven A. Harlow 7
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3.3.2 Edit Menu

The SigmiraRx Text window Edit menu has one entry, 'Clear text'. Selecting 'Clear text' clears
the received text display.

3.4 Phase Plane Display

The Phase Plane display can be brought up by selecting View->Phase Plane from the main
window menu bar.

B Phase Plane E| @| g|

Figure 4 - Phase Plane Window

The phase plane displays the time varying phase and amplitude of the signal. The phaseis
relative to the tuning VFO. At any instant in time the phase and amplitude of the signal are
represented by apoint in the display. The amplitude is represented by the distance of the point
from the center of the display. The phaseis represented by the angle of the point around the
center. Positive angleis counter-clockwise. To theright is O degrees, up is 90 degrees, left is 180
degrees, and down is 270 or -90 degrees. If a constant amplitude pure carrier of the same
frequency and phase of the VFO were being received it would be displayed as a dot to the right of
the center. If the carrier were 1 Hz higher in frequency than the VFO the dot would revolve
around the center counter-clockwise making one revolution per second.

A Binary Phase-Shift Keying (BPSK) High Frequency DataLink (HFDL) signal is shown in the
figure above. In the absence of noise and distortion a BPSK signal would appear as two dots 180
degrees opposite each other with aline between them. Distortion in the radio wave propagation
causes the wiggling seen above.

Copyright 2009, Steven A. Harlow 8
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The phase plane display is appropriate for viewing phase modulated signals such as PSK 31,
STANAG 4285, HFDL, etc. Certainly it isalso of interest out of general curiosity. Anditisaso
useful asatuning and calibration indicator.

An AM signal will generally appear as aline segment radiating from the center of the display. If
Sigmiraistuned exactly to the carrier frequency the line will be stationary and not revolve around
the center. Asmentioned above, if the signal is 1 Hz higher in frequency the line will revolve
around the center counter-clockwise at 1 Hz. This makes the phase plane a sensitive tuning
indicator. Thisisuseful in calibrating the SDR-1Q. See section 3.16.1.

The phase plane display is functional in al of Sigmira's demodulation modes.

Inthe AM, USB, and L SB modes the Demod Width setting is effective. In those modes the
signal content on both sides of the tuning frequency are processed into the phase plane display
(i.e. USB and L SB modes do not cut off the sidebands in the phase plane display.) Itis
appropriate and advantageous to set the Demod Width to a minimum which includes the signal of
interest and excludes outside noise. The Demod Width is the one-sided width. So, if oneis
viewing a phase modulated signal with atwo-sided (total) width of 2 kHz, the Demod Width
should be set to 1 kHz.

In the PSK31 mode the Demod Width setting is not important. 1n addition, the demodulator locks
phase with the signal and that is reflected in the phase plane display. With agood signal the
displayed phase will bounce between approximately 0 degrees and 180 degrees.

Inthe RTTY mode the phase plane display is used to instead to approximate the old style RTTY
tuning indicators. The 'mark’ filter drives the horizontal axis and the 'space’ filter drives the
vertical axis. The implementation is crude and of limited usefulnessin RTTY mode.

3.5 Modes

The Mode refersto the type of signal, AM, USB, LSB, RTTY, PSK31, CW, or STANAG 4285.
The mode setting selects which type of signal the program demodulates. The currently active
mode is selected by clicking on the particular Mode 'radio button' in the 'Mode' group in the upper
left corner of the program window.

Cam o (O 35M
(3 use () MFM

ise O Fsk
) Pskat C

() RTTY

oy

() 54285
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Figure 5 - Mode

3.51 AM

The AM isthe usual Amplitude Modulation that everyoneis familiar with. AM istypically used
to send audio signals. The"AM broadcast band" (also know as MW or "medium wave") ranges
from 520 to 1610 (1710 in the US) kHz. International short-wave broadcasters operate on several
bandsin the 3to 30 MHz range. AM can also be described as double sideband (DSB) with
carrier. AM signals can have various widths, 10 kHz and 20 kHz being common.

S L

-1po00: 1] -'1-|:||:| [}
IR el T el G T I A e i bl Il Sl L el R el R

11

Figure 6 - Typica AM Signal
Totuneinan AM transmission click on the AM radio button in the Mode group in the upper left
corner of the Sigmirawindow. Then select the particular transmission to demodulate by right-
clicking on it in the waterfall display.

For the optimum signal to noise ratio the demodulation width should be adjust to match the
signal. See section 3.8 "Demodulation Width". For the signal in the above figure a demodulation
width of 10 kHz would be appropriate.

AM broadcast signals have modulation bandwidths of 5 or 10 kHz, typically.

The sguelch control can be used to reduce response to noise. See section 3.11, Squelch Control.

3.5.2 USB

USB stands for Upper Sideband. It is one of the two single sideband (SSB) modes. SSB is
normally used to send audio signals. Normal amplitude modulation produces two sidebands, one

Copyright 2009, Steven A. Harlow 10
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on each side of the carrier. The audio information isin the sidebands and the sidebands are mirror
images of each other. SSB was developed to be more efficient than AM. Only one sideband is
transmitted, thus SSB signals are narrower. There are two advantagesto that. 1. More signals
can be packed into the same bandwidth and 2. the reduced receiver bandwidth allows less noisein
with the signal. Typically the carrier is suppressed too which is an additional power savings at
the transmitter. The down side to SSB is that demodulating the signal is more complex. The
receiver must either reinsert alocally generated approximation of the carrier or use a complex
signal and the Hilbert transform. And tuning iscritical. If thereceiver istuned to high or low in
frequency the resulting audio is shifted up or down giving what is described as a Donald Duck
sound.

Since an AM signal has two sidebands there are two choices as to which sideband to transmit for
SSB. Thus Upper Sideband (USB) and Lower Sideband (LSB). Hams make extensive use of
SSB. By convention they use LSB below 10 MHz and USB above 10 MHz.

The USB or L SB receive modes can sometimes be used for improved reception of aregular AM
signa. If thereisan interfering signal that affects one sideband of an AM signal more than the
other one can use the appropriate SSB mode to demodul ate the sideband suffering the least
interference. Another case where SSB receive mode can be used to advantage on an AM signal is
when the AM signal is experiencing severe frequency selective fading. In instances where the
carrier specifically isfaded out the sound can be particularly distorted using the normal AM
demodulation mode. Switching to SSB significantly reduces the distortion because SSB
demodulation does not use the carrier.

-El:lEII:I | i | EI:II]I:l :

il
%

Figure 7 - Upper Sideband (USB)

Copyright 2009, Steven A. Harlow 11
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3.5.3 LSB

L SB stands for Lower Sideband. It istheflip side of Upper Sideband, USB. See USB above.

3.5.4 PSK31

PSK 31 is a narrow-band character-based modulation mode used by hams for interactive long
distance communication in the HF bands. PSK 31 employs Binary Phase Shift Keying (BPSK),
Huffman coding, and alow baud rate. Those features are particularly suited to the HF bands
which offer over-the-horizon and world wide propagation with the challenges of ionospheric
fading and limited frequency resources.

Figure 8 - PSK 31 Signals

PSK 31 signals can regularly be found at 7070 kHz and 14070 kHz. The lower frequency, 7070
kHz, is more active evenings and the higher frequency is more active middays. A PSK31 signal
appears as a bright column in Sigmira's waterfall display. Figure 8, above, is an example of the
appearance of PSK31 signals. That exampleisfrom a particularly active period but it is common
that there are many signals visible at onetime. The narrowband nature of PSK31 signals allows
many signals to be placed close together, even within the passband of a short-wave
communications receiver, and thus be visible at the same time at one receiver frequency setting.

To demodulate a PSK 31 transmission click on the PSK 31 radio button in the Mode group in the
upper left corner of the Sigmirawindow. Then select the particular transmission to demodulate
by right-clicking on it in the waterfall display. The demodulated text will appear in the Rx Text
window.

Copyright 2009, Steven A. Harlow 12
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Sigmira uses a narrow filter to separate the selected transmission from the rest of theinput. The
signal strength indicator indicates the strength of thefiltered signal. The waterfall display
continues to display the entire input.

The SDR-I1Q has something of a"0 Hz birdie". Samples from the SDR-1Q have a DC offset that
shows as a peak or faint line at the center of the spectrum/waterfall. It can interfere with PSK31
demodulation (when 'Lock Center' is off). The offset can be minimized with the 'DC Comp.'
feature described below. However in some casesit may till be advantageous to tune slightly off
from the PSK31 signal (so that it is not at the center of the spectrum), turn ‘Lock Center' on, and
then tune directly on the PSK31 signal.

The sguelch control can be used to reduce response to noise. See section 3.11, Squelch Control.

3.5.5 RTTY

RTTY (Radio Teletype) is anarrow-band character-based modul ation mode used by hams for
interactive long distance communication in the HF bands. RTTY employs Frequency Shift
Keying (FSK) modulation, "Baudot" coding, and alow baud rate. Those features are suited to the
HF bands which offer over-the-horizon and world wide propagation with the challenges of
ionospheric fading and limited frequency resources. RTTY isone of the earliest forms of digital
modulation having originated probably before the 1940s. Assuch it doesn't include the more
modern features of Huffman coding and phase shift keying that PSK31 does. . (Note that the
Sigmira RTTY mode is specifically oriented to the ham FSK signal. For the general FSK
demodulation mode see the FSK mode section, below.)

Figure9- RTTY Signal

Copyright 2009, Steven A. Harlow 13
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RTTY signals can generally be found from 7080 kHz to 7100 kHz and 14080 kHz to 14100 kHz.
The lower frequency range is more active evenings and the higher frequency range is more active
middays. (When using an external receiver connected to the sound card input set the receiver to
USB mode.)

The frequency shift for RTTY signalsis 170 Hz. The higher frequency isthe "mark™ frequency
and the lower frequency isthe "space" frequency. The baud rateis45.45. A RTTY signal
appears asapair of bright column in Sigmira's waterfall display. Figure 9, above, isan example
of the appearance of aRTTY signal.

To demodulate aRTTY signal click onthe RTTY radio button in the Mode group in the upper
left corner of the Sigmirawindow. When in RTTY mode two triangles are shown on the
frequency scale. Thetriangle to theright isred and corresponds with the ‘Mark' frequency.
Right-click on the higher frequency column of the desired signal, i.e. the mark frequency. (It is
easier to click on asignal when the displayed spectrum width is narrower.) The demodul ated text
will appear in the Rx Text window. (When using a conventional receiver with Sigmirafor RTTY
demodulation make sure the receiver isin USB mode.)

Sigmira uses a narrow filters to separate the selected transmission from the rest of the input. The
signal strength indicator indicates the strength of thefiltered signal. The waterfall display
continues to display the entire input.

The squelch control can be used to reduce response to noise. See section 3.11, Squelch Control.

3.5.6 FSK

FSK (Frequency Shift Keying) is a mature, uncomplicated "digital” mode. It isgenerally used for
character-based communication. It originated before the 1940s and is still used by military,
government, and private maritime entities for long-haul, over-the-horizon communication on the
HF bands. Hams also use FSK. Sigmirahas a separate RTTY mode that is specifically oriented
to the ham FSK mode.

Sigmira's FSK mode can a so be used to demodulate SITOR-B signals.

There are over adozen entries for FSK signalsin the Sigmira signal database. There are currently
four entriesfor SITOR-B signals. There are many FSK signals that run almost constantly. They
are most commonly 850 shift and 50 or 75 baud. They are also typically encrypted. Some of the
stronger signals received in southern California are 5345, 7593, 9085, and 14436.3 kHz (center).

At least two of the SITOR-B signals heard in southern Californiaare from NMC. They consist of
maritime weather information (unencrypted). They are at 8416.5 and 12579 kHz (center).

To demodulate an FSK signal click on the FSK radio button in the Mode group in the upper left
corner of the Sigmirawindow. When in FSK mode two triangles are shown on the frequency
scale. Thetriangleto theright isred and corresponds with the 'Mark' frequency. Right-click on
the higher frequency column of the desired signal, i.e. the mark frequency. (It iseasier to click on

Copyright 2009, Steven A. Harlow 14
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asignal when the displayed spectrum width is narrower.) The demodulated text will appear in the
Rx Text window. (When using a conventional receiver with Sigmirafor FSK demodul ation make
sure the receiver isin USB mode.)

Sigmira's FSK mode offers user selectable shift, baud rate, mark/space inversion, and source
format.

The FSK Control window is displayed whenever the FSK mode is selected (from the mode
buttons in the upper left corner of the main window) or when called up viathe View menu,
View=>FSK Control, aso in the upper left corner of the main window. The FSK Control
window appears as below:

W FSK Control M[=1E3
Shift {Hz)
Q170 O20 O40 Osso ®sso O (170 |
Baud Rate - ——
O4s45 Os0 @7 Owo O (100
[] MarkySpace Invert
Source Farmak
() Binary (O ITaz O ASCI O CCIR4TE
Bits Per Character (ASCIT only)
OR: TS
Parity (ASCIT only)
%) Mone ) odd ) Even
Stop Bits (ASCIT only)

@10z

sl

The Shift radio buttons allow the demodulator to be set to match the frequency shift of the
received signal. The shift of the received signal is most easily observed when the displayed
spectrum width is set at lower values, i.e. 25 kHz or less. When in the FSK mode two triangles
are shown on the frequency scale. They correspond to the 'mark’ and 'space’ frequencies.
(Typically the higher frequency is the mark frequency.) Select the shift so that the separation of
the triangles matches the separation of the displayed columns of the received signal. Then right-
clicking on the mark column in the waterfall display tunes the demodulator so that the red triangle
isover the mark frequency and the yellow triangle is over the space frequency. Most signals are
either 170 or 850 shift. The FSK Control window offers preset buttons for several known shift
values. In addition the far right shift button allows the selection of a shift value that can be
entered by the user.

The Baud Rate radio buttons allow the demodulator to be set to match the baud rate of the
received signal. Most 850 shift signals are either 50 or 75 baud. Amateur RTTY signals are 45.45
baud (170 shift). SITOR-B signalsare 100 baud (170 shift). Selection of the correct baud rate
can be verified in the eye diagram described below. The FSK Control window offers preset

Copyright 2009, Steven A. Harlow 15
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buttons for the common baud rates. In addition the far right baud rate button allows the selection
of arate that can be entered by the user.

The Mark/Space Invert checkbox alows the swapping of which frequency isinterpreted as mark
and which as space. Normally the higher transmitted frequency ismark. A few stations transmit
mark as the lower frequency. In addition, when using a conventional receiver it is common for
the receiver to switch to lower sideband mode below 10 MHz. That swaps the mark and space
frequencies. The Mark/Space Invert checkbox can be used to adapt the demodulation to an
inverted sender or to alower sideband swap.

The Source Format radio buttons allow one to select the final interpretation of the data for display
in the Rx Text window. The'Binary' modeis basically no interpretation. The individual bits are
displayed. The binary mode is appropriate for encrypted transmissions because the encryption
conceals the original source format. The binary mode is also useful in assessing unknown signals
and looking for patterns that indicate the actual format. The regular pattern of start and stop bits
isusually apparent when viewing ITA2 datain binary mode. The 'ITA2' mode prints data
formatted at the source in the 5-bit start stop serial ITA2 alphabet. (ITA2 issometimes referred to
as "Baudot".) The'ASCII' mode prints data formatted at the source in the common 7 or 8-bit start
stop seria format. The control window also includes options for the number of bits, parity bits,
and stop bits. Those settings are only effective in the ASCIl mode. The 'CCIR476' format is used
by SITOR-B and NAVTEX. (In CCIR476 characters are seven bit long with exactly four '1' bits
per character. Each character is sent twice with the repeated characters being interleaved and
delayed by five characters.)

The LTRS and FIGS button allow the LTRS/FIGS state of the demodulator to be manually
changed. Both ITA2 and CCIR476 use a LTRS/FIGS state to extend the range of characters that
may be sent. The five bits of an ITA2 character and the seven bits of a CCIR476 character
basically only allow for about 32 different characters. "LTRS" and "FIGS' control characters are
used to tell the demodulator to switch back and forth between two tables of meanings for the
transmitted character. When in the LTRS state '10000' (ITA2) means'T' and when in the FIGS
state '10000' means'S'. The demodulator must track the LTRS/FIGS state. Noise, interference,
and fading can cause the demodulator to miss or receive false LTRS and FIGS control characters
and thuslose track. Inthat case a string of inappropriate letters or figures will be observed in the
received text display. If the demodulator is erroneously in the FIGS state clicking the LTRS
button forces the demodul ator back to the LTRS state. Likewise the FIGS button forces the
demodulator to the FIGS state. The LTRS and FIGS buttons in the FSK Control window are also
effective when Sigmiraisin RTTY mode.

The eye diagram display is shown below.
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The eye diagram allows the signal quality and the demodulated bit timing to be observed. With a
good quality signal and the correct baud rate selected the diagram appears as above. Thereisone
complete "eye" that is centered and "open”. The signal zero-crossing points are at the ends of the
greenline. Notethat ITA2 and ASCII signals can haveirregular bit timing. The functioning of
the eye diagram is adjusted to compensate for that when the ITA2 or ASCII source format is
selected.

The Phase Plane display displays the output of the mark and space filters rather than phase while
in FSK mode. The mark filter output is displayed in the horizontal direction and the space filter
output is displayed in the vertical direction.

Two recorded examples of FSK signals are included in the Sigmira package. They can be found
at <sigtools install_root>/examples/fsk_8r432 090418 1236 ksm.wav and

<sigtools install_root>/examples/sitorb_8r432 090418 1504 ksm.wav. The FSK exampleis
1000 Hz center, 170 shift, 45.45 baud, ITA2. The SITOR-B exampleis 1000 Hz center, 170
shift, 100 baud, CCIR476. To demodulate the SITOR-B example open the .wav file using the
"File" menu in the main Sigmirawindow. (Refer to section 7 of this document for more details
on opening .wav files.) Set the tuning frequency to 1000 Hz in the frequency control of the main
window. (Section 3.8 can be referred to for more details on frequency setting.) Select "FSK" in
the "Mode" menu in Sigmira's main window. Then in the "FSK Control" window select the 170
Hz shift. Select the 100 baud rate. The Mark/Space Invert box should be unchecked. Set the
"Source Format" option to "CCIR476". The decoded text should appear in the Rx Text window
as shown below.
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File Edit
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The sguelch control is usable in the FSK mode.

3.5.7 CW

CW isold fashioned Morse code over radio. "CW" stands for "continuous wave", which isa
historic term arising from the fact that the very first transmitters of a hundred years ago could not
always produce the long 'dash’ sound.

CW is"low tech”. It requiresthe least hardware. All one needsto transmit a CW signal isaradio
frequency generator with an on-off switch. That ssmplicity plus a nostalgia factor account for the
longevity CW. CW does place greater demands on the receiver software, which has traditionally
been implemented in a human being.

(B II;I Bl e B e Ill:ll:"EI

Figure 10 - A CW Signa

Copyright 2009, Steven A. Harlow 18



Sigmiraa 1r5 May 3, 2009

Interestingly, Morse code incorporates a basic concept that has been most recognized in the more
modern Huffman coding. Huffman codes were invented some one hundred and twenty years
later. In both codes the most common characters are mapped to the shortest transmit sequences.

CW signals can generally be found from 7000 kHz to 7070 kHz and 14000 kHz to 14070 kHz.
The lower frequency range is more active evenings and the higher frequency range is more active
middays.

A CW signal appears as a bright column in Sigmira's waterfall display. To demodulate a CW
signal click on the CW radio button in the Mode group in the upper left corner of the Sigmira
window. Then select the particular transmission to demodulate by right-clicking on the signal in
the waterfall display. Initially Sigmira has to adapt to the rate at which the code is being sent.
CW can be sent at arate anywhere from 3 words per minute to 60 words per minute. While
adapting Sigmirawill typically print anumber of 'E'sin the Rx Text window. With a decent
signal Sigmirawill adapt to the correct speed within 10 seconds

Sigmirauses avery narrow filter to select the CW transmission out of the total input. The signal
strength indicator indicates the strength of the filtered signal. The waterfall display continues to
display the entire inpuit.

(The CW filter isfixed at 50 Hz and is perhaps too narrow for some uses. If the automatic to-text
deciphering is not need then CW can be listened to in the USB mode. A selectable range of CW
filterswill be added to a future version of Sigmira.)

The SDR-1Q has something of a"0 Hz birdie". Samples from the SDR-1Q have a DC offset that
shows as a peak or faint line at the center of the spectrum/waterfall. It can interfere with CW
demodulation (when ‘Lock Center' is off). The offset can be minimized with the ' DC Comp.'
feature described below. However in some casesit may still be advantageous to tune slightly off
from the CW signal (so that it is not at the center of the spectrum), turn 'Lock Center' on, and then
tune directly on the CW signal.

In CW mode the 'Squelch' control can optionally be used to set the signal level that is considered
as "key down". When the signal level is above the squelch level it is considered a"key down"
period, i.e. part of a'dit' or a'dah’. When the signal level is below the squelch level it is consider
to bea"key up” interval, i.e. between a'dit' or ‘dah’. But it isnot necessary that the best setting
for this control be selected manually. If the squelch level isset at O, at the bottom, the program
automatically adjusts to what it calculatesis the best level.

Also see section 3.11, Squelch Control.

3.5.8 STANAG 4285
STANAG 4285 is adigital modulation mode designed by NATO for HF radio communications.

It appears to be used mostly for long haul broadcast communication by various navies/maritime
organizations. STANAG 4285 is a 2400 baud, 8-PSK signal.
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The symbol rate is always 2400 symbols per second but various modulation options result
in datarates from 75 to 3600 bps. The 2400 sps rate and PSK modulation result in a
bandwidth of about 2400 Hz. Thus STANAG 4285 iswider than many HF data signals
but still fits in the bandwidth of atypica voice signal. The signal has a 256 symbol frame
structure which includes an 80 symbol synchronization pattern and three 16 symbol
reference patterns. The sync and reference patterns along with 8-ary symbol scrambling
facilitate adaptive channel equalization. Channel equalization is advantageous for a high
datarate signal in the HF band considering the associated ionospheric fading. The sync
pattern also facilitates Doppler adaptation as well as frame synchronization and symbol
rate adaptation.

STANAG 4285 provides for forward error correction (FEC). FEC adds redundancy to the
data such that the receiver can detect and generally correct errorsin the received data. In
STANAG 4285 FEC isimplemented in arate 1/2, constraint length 7 convolutional code
and interleaver. The convolutional code effectively adds as many "parity” bits asthere are
data bits, thus the source datarate is 1/2 the coded data rate. Decoders for convolutional
codes are less effective against bursts of errors. Bursts of errors are common in radio
channels so an interleaver istypicaly employed along with a convolutional code. The
interleaver shuffles the order of the data bits. A deinterleaver in the receiver reversesthe
interleaving. The errors of a bursts of errors caused by the radio channel are spaced out by
the deinterleaver in the receiver.

The length of the interleaver in STANAG 4285 is a selectable option. Two nominal
values are available, "short" and "long". The longer interleave is more resistant to channel
noise bursts and fades. The length of the interleaver also corresponds with areal time
delay in the data becoming available at the output of the demodulator. The "short"
interleave corresponds with a delay of about 1 second. The "long" interleave corresponds
with adelay of about 10 seconds. So if the "long" interleave option is selected any
disturbance or change in the received signal won't be evident until 10 seconds later.

The STANAG 4285 specification includes an optional "message mode". The message
mode is something of adigital squelch. The message mode specifies a"start of message”
bit pattern (SOM) and an "end of message" bit pattern (EOM). When the message mode
is selected the receiver is only to output data after a SOM is detected and before the next
EOM isdetected. In this observer's opinion the message mode is something of a
misfeature. There are other less error prone methods of achieving the same result and no
known actual users of STANAG 4285 use the message mode.

Sigmira employs an adaptive decision feedback equalizer (DFE) for channel equalization
and a Viterbi decoder for the convolutional code.

STANAG 4285 transmitters have typically used a modem that produces an audio signal whichis
then the input to an USB transmitter. The carrier or center of the audio band STANAG 4285
signal is specified as 1800 Hz. The commonly quoted frequency for a STANAG 4285 radio
signal isthe tuning of the USB transmitter. So the actual center of the STANAG 4285 RF signal
is 1800 Hz higher than the quoted frequency. Sigmiratuning is oriented to the center of the
signal. When using Sigmirawith the SDR-1Q the frequency setting should be the commonly
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guoted frequency plus 1800 Hz. When using Sigmirawith a conventional receiver tune the
receiver to the commonly quoted frequency, USB mode, and set Sigmirato 1800 Hz.

Monitoring from southern California STANAG 4285 signals are often found around 6500 kHz
and 8500 kHz. They are more common and stronger at night. A couple common signals are at
6400.5, 8490, and 8554.4 kHz (center). All observed signals have data rates of either 300 or 600
bits per second. A dlight majority operate at 300 bits per second. All of them operate with the
long interleave option.

Most of the observed signals appear to be encrypted. (The bit autocorrelation is flat and the run
length statistics are the same as a Bernoulli process.) But there are signals transmitted in the
clear. The French navy has been broadcasting several test signalsin the clear for some time now.
Examples are 8480.3, 8626.8, and 8647.8 kHz (center). The 8626.8 signal is at 600 bps. The
others are 300 bps. All usethelong interleave. They use the ITA2 alphabet.

The spectrogram of a STANAG 4285 signal isgiven in Figure 11, below. Thisisnot a
particularly strong signal. Significant fading is also evident. Even so, good copy was obtained

from thissignal.

Figure 11 - STANAG 4285 Signal Spectrogram

To demodulate a STANAG 4285 transmission click on the $S4285 radio button in the Mode group
in the upper left corner of the Sigmirawindow. The Rx Text window and STANAG 4285
Control window should appear.
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Figure 12 - STANAG 4285 Control Window

In the upper part of the control window are two indicators, the Sync indicator and the FEC
Quality indicator. The Sync indicator illuminates green when Sigmiralocks on to the
synchronization of a STANAG 4285 signal. (Since the signal energy from 80 out of every 256
symbols contributes to sync detection it is possible detect sync even from signals which are too
poor to yield good payload data.) The FEC Quality indicator is athermometer type graph that
indicates the quality of the demodulated data before the Viterbi decoder. If the indicator is above
the 70% level the Viterbi decoder is able to correct virtually al errors. Good copy can still be
obtained in the 50 to 60% range. (Note that the FEC Quality indicator is after the deinterleaver.
If the interleave setting is changed to 'Long' or if the tuning is changed there will be a 10 second
delay before the FEC Quality indicator gives atrue indication.)

The Data Rate radio buttons in the control window allow the selection of the signal's expected
datarate. It appearsthat virtually all real signals are either 300 or 600 bits per second. For an
unknown signal one can determine the data rate by switching between the two rates and observing
the FEC Quality indicator. The FEC Quality indicator will be near zero for the incorrect rate.
(Setting the data rate to a value above 600 bps also affects the deinterleaver. After changing the
datarate to a value above 600 or back again one must wait the interleaver delay, 10 seconds for
the 'Long' interleave, before the FEC Quality indication catches up.)

The Interleave radio buttons in the control window allow the selection of the signal's expected
interleave. It appearsthat virtually all real signals use the long interleave. Theinterleave results
in areal time delay through the demodulator. The short interleave results in adelay of about 1
second. Thelong interleave resultsin about 10 seconds. Changing the interleave setting resets
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the deinterleaver and the interleave delay must pass before good data works its way through the
deinterleaver again. The interleaver isalso reset if the datarate is changed to or from any value
above 600.

The Source Format radio buttons allow one to select the final interpretation of the data for display
in the Rx Text window. The 'Binary' modeis basically no interpretation. The individua bits are
displayed. The binary mode is appropriate for encrypted transmissions because the encryption
conceals the original source format. Most signals appear to be encrypted. The binary mode is
also useful in assessing unknown signals and looking for patterns that indicate the actual format.
The regular pattern of start and stop bits is quite apparent when viewing ITA2 datain binary
mode. The'ITA2 mode prints data formatted at the source in the 5-bit start stop serial ITA2
alphabet. (ITA2issometimesreferred to as"Baudot".) Several real broadcast test signals have
been observed using ITA2. The'ASCII' mode prints data formatted at the source in the common
7 or 8-hit start stop serial format. The control window also includes options for the number of
bits, parity bits, and stop bits. Those settings are only effective in the ASCII mode.

The Message Mode check box controls the STANAG 4285 specified optiona "message mode”.
When in the message mode the printing of demodulated data begins when the specified "start of
message” bit pattern is detected and ends when the specified "end of message” bit patternis
detected. When not in message mode all data are printed. Message mode filtering is never
applied when the '‘Binary' Source Format is selected.

The Sync Detect radio buttons alow one to choose between two signal synchronization detector
settings. With the 'Optimal’ setting the sync detector is optimized for stable synchronization and
minimal errors for both good and marginal signals per the STANAG 4285 specification. The
'Quicker' setting modifies the sync detector to synchronize instantly when given agood quality
signal. Instant synchronization is not part of the mission of STANAG 4285. Generally the Sync
Detect option should remain set to Optimal.

B Phase Plane E”E'!J

Figure 13 - Phase Plane Display for STANAG 4285 Signal

Figure 13 above illustrates the phase plane display when a high quality STANAG 4285 signal is
being received. The end points of the radials correspond to the received symbols. The 8-PSK
nature of the signal is quite clear. Note that at the lower data rates, including 300 and 600 bps,
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good copy is possible even with signals so noisy and distorted that an 8-PSK constellation is
hardly recognizable in the phase plane. (The constellation in the phase plane is distinctly eight-
pointed only when the signal is greater than the noise floor by 15 dB or more.)

A recorded example of a STANAG 4285 signal isincluded in the Sigmira package. To
demonstrate Sigmira's STANAG 4285 operation begin by opening the example STANAG 4285
wav file. The exampleisinthe "examples' directory and is named

"s$4285 081020 2200 8r6268 600lita2 fnav_fum.wav". Wave files are opened using the "File"
menu in the main Sigmirawindow. (Refer to section 7 of this document for more details on
opening .wav files.) Set the tuning frequency to 1800 Hz in the frequency control of the main
window. (Section 3.8 can be referred to for more details on frequency setting.) Select "$4285" in
the "Mode" menu in Sigmira's main window. Then in the "S4285 Control™ window select the
"600" bps datarate. The "Interleave" option should also be set to "Long” (which is the default).
Set the "Source Format" option to "ITA2". The"Message Mode" check box should be unchecked
(which isthe default). The signal will then be demodulated and wend its way through the
deinterleaver and Viterbi decoder. After about 10 seconds text as shown below in Figure 14 will
appear in the Rx Text window.
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File  Edit
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Figure 14 - Text of the French Navy FUM STANAG 4285 Test Signal

3.5.9 JSM (Japanese Navy "Slot Machine")

JSM refersto arather strange signal. The consensusisthat it is transmitted by the Japanese navy.
When one listensto it in USB mode it normally sounds like a continuous repetitive melody.
Some have likened the sound to that of a Las Vegas slot machine. Thus the name, JSM, Japanese
Slot Machine.
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In Californiait is commonly best received after 22:00 (local) and up to the hour after sunrise
(local) on 6.446 and 8.589 MHz (center). It has aso been heard on 4.154, 4.2325, 4.291, 6.251,
6.418, 8.314, 8.7045 MHz (center).

A recorded .wav file example of the signal isinclude in the Sigmiradistribution package. It can
be found at <sigtools _install_root>/examples/jsm_080904 0651 8r5888 example.wav. Sigmira
displays the example as shown below:

A recent live capture is shown below.

Copyright 2009, Steven A. Harlow 25



Sigmiraa 1r5 May 3, 2009

W SIGHIRA FBEX
Fle Yiew Source Calbrate Help
Mode Spevfﬁ‘;t":“ Demod Widkh Squelch  olume 2009/03/08 06:54 03 | UTC
W 2o I -~
O & @ 13M o Tause [ Lock Center ® 1k | B 2009/03/07 22:54 03 | Local
Cuse O MFM il
) 5kHz & 35de QO 25kHz| [
(3 10kHz () a0de | O 3kHz
DC Comp. o !
S P == 06 . 446 000K
RTTY
o () 50 kHz T ) 10kHz
i !
o O 100kHz |
54285
O z00kHz | | -5dB 5 =

(dBm)|

Lo S 7

Most of the time the signal is an exactly repeating melody. It aso includes an 11.4 Hz ticking
sound. The melody repeats every 5.6 seconds. Thisisodd. Information theory tells us that the
more predictable asignal isthe lessinformation it contains. This repeating signal contains
basically no more than three pieces of information: a frequency, a phase, and a station ID.
Occasionally the signal changes to become more chaotic and noise-like. That isthe information
payload. The melody intervals of the signal are called the "idle" time here.

The observed characteristics of the signal are consistent with afixed (land based) broadcast to
multiple, likely mobile, receivers over the horizon. The signals run continuously without
interruption. The content of the signal on each of the various transmit frequencies appears
identical. Thereisnever anything like a"reply".

The actual frequency of the nominal 8.589 MHz signal has been measured at 8.588997 MHz +/-
0.5Hz. Sothesignal isnot atop stratum frequency reference (such as NIST WWV).

A snapshot of the signal in the phase plane is shown in the image below. (The "Demod Width"
was set to 1 kHz.)
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B Phase Plane [Z|[E|SJ

Clearly itisaQPSK signal.

With some investigation the symbol rate was determined to be 1500.00 baud. The regular ticking
sound was found to be an exactly repeating sequence of symbols. Clearly that serves as a channel
probe and frame synchronization pattern. Onetick sound period is here defined as a"frame".
Frames were found to consist of 140 QPSK symbols. So the framerateis 10.71428 Hz. The
probe/sync pattern is 28 symbols which is one fifth the number of symbols per frame. It isfound
that, during the repetitive melody idle time, the remaining symbols of aframe consist of four
repetitions of another 28 symbol pattern. So aframe appearsto consist of five "blocks" of 28
symbols.

During idle time there is afinite set of symbol patterns that appear in the blocks. The patterns are
designated here: ps, p0, pl, p2, p3, p4, p5, p6, p7, p8, p9, pl0, and pl1l. The"ps' patternisthe
probe/sync pattern. The rest are numbered roughly in the order of their frequency of occurrence.
The"p0" pattern is most common.

The melodic idle time consists of an exactly repeating sequence of 64 frames. A 64 frame
sequenceis called a"super frame" here. The duration of a super frame is 5.973333 seconds. The
frame/block pattern of the idle super frame is presented in the following table.

Idle Super Frame Structure

Frame Block O Block 1 Block 2 Block 3 Block 4
Number Pattern Pattern Pattern Pattern Pattern

0 ps p10 p10 p10 p10

1 ps p10 p10 p10 p10

2 ps p10 p10 p10 p10

3 ps pO pO pO pO

4 ps P8 P8 p8 p8

5 ps p8 p8 p8 p8

6 ps p8 p8 p8 p8

Copyright 2009, Steven A. Harlow

27




Sigmiraa 1r5 May 3, 2009
ps pO pO pO pO
ps p9 p9 p9 p9
ps p9 p9 p9 p9

10 ps p9 p9 p9 p9
11 ps pl pl pl pl
12 ps pll pll pll pll
13 ps pll pll pll pll
14 ps pll pll pll pll
15 ps pO pO pO pO
16 ps p6 p6 p6 p6
17 ps p6 p6 p6 p6
18 ps p6 p6 p6 p6
19 ps pO pO pO pO
20 ps [019) [019) p5 p5
21 ps p5 p5 p5 p5
22 ps 019) 019) p5 019)
23 ps pO pO pO pO
24 ps p4 p4 p4 p4
25 ps p4 p4 p4 p4
26 ps p4 p4 p4 p4
27 ps pl pl pl pl
28 ps p3 p3 p3 p3
29 ps p3 p3 p3 p3
30 ps p3 p3 p3 p3
31 ps pl pl pl pl
32 ps pll pll pll pll
33 ps pll pll pll pll
34 ps pll pll pll pll
35 ps pO pO pO pO
36 ps p7 p7 p7 p7
37 ps p7 p7 p7 p7
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38 ps p7 p7 p7 p7
39 ps pl pl pl pl
40 ps p3 p3 p3 p3
41 ps p3 p3 p3 p3
42 ps p3 p3 p3 p3
43 ps pO pO pO pO
44 ps pO pO pO pO
45 ps pO pO pO pO
46 ps pO pO pO pO
47 ps pl pl pl pl
48 ps pO pO pO pO
49 ps pO pO pO pO
50 ps pO pO pO pO
ol ps pl pl pl pl
52 ps pO pO pO pO
53 ps pO pO pO pO
54 ps pO pO pO pO
55 ps pO pO pO pO
56 ps pl pl pl pl
S7 ps pl pl pl pl
58 ps pl pl pl pl
59 ps pO pO pO pO
60 ps p0 pO0 pO pO
61 ps pO pO pO pO
62 ps pO pO pO pO
63 ps pl pl pl pl

The choice of which frame in the super frame should be designated as frame 0 was somewhat

arbitrary. The numbering in the above table is used as the convention in this document.

The melody arises from the regular repeated simple patterns of symbols/phases. The p10 pattern
isall onephase. So it producesasingletone. The pl11 patternisalso all one phase but 180
degrees from p10. The other patterns are somewhat more complex and result in different and

multiple apparent tones.

Copyright 2009, Steven A. Harlow

29




Sigmiraa 1r5 May 3, 2009

There are times that the signal departs from the idle pattern and sounds more "noisy”. That isno
doubt the data payload. There are typically from 4 to 20 such dataintervals per hour. There
seems to be no pattern to the minute of the hour at which dataintervals begin. The length of each
datainterval is an exact multiple of super frames. At the end of adatainterval the idle pattern
resumes exactly in step and alignment asif there had been no interruption. So there appears to be
an underlying continuous 64-frame super frame structure to the signal.

It appears that each datainterval begins at frame 31 or frame 32 in the super frame (by the frame
numbering convention here). Likewise the signa returnsto idle at frame 31 or 32. There appear
to be several formats for dataintervals. They can roughly be characterized by the number of
frames consisting of the fixed 'p' patterns (described above) that are mixed in with frames
containing the data. The data interval super frames generally consist of a repeating pattern of four
frames, some of which are random (data) symbols with the rest being the fixed patterns. The
number of data framesin those four frame groups can vary from one to four. Data super frames
in which less than al four frames of the four frame groups are data could be called "partial" data
super frames. Data super frames in which every frame contains data could be called "full" data
super frames. The full data super frames are often preceded and followed by partial data super
frames.

The suspected data symbols have been extracted and analyzed via autocorrelation. The symbols
were also converted to bits according to an expected Gray code. The autocorrelations have been
flat indicating that the symbols are further coded and/or encrypted.

The abrupt boundaries of the data super frames could expose evidence of convolutional coding or
interleaving if used. Such evidence has not been obvious in the observed signals.

Sigmira uses the 'ps block of the signal frames to accomplish carrier recovery, symbol
synchronization, frame synchronization, and channel equalization. The carrier reference phase
was somewhat arbitrarily chosen such that the 'pl0' pattern symbols are at 90 degrees. (0 degrees
isto theright in the Sigmira phase plane display. 90 degreesis up.)

Sigmira displays the demodulation resultsin the "Rx Text" window. An exampleisgiveninthe
figure below.
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The above display resulted from demodulating the included example file:

<sigtools install_root>/examples/jsm 080904 0651 8r5888 example.wav.

(Set the tuning frequency to the center of the signal, which is 1000 Hz for the examplefile.) The
above display shows atransition from an idleinterval to a"partial” datainterval.

The display consists of one frame per line.

The first number in each line is the number of the frame in the super frame. Note that Sigmira
must first detect the idle super frame pattern in order to synchronize the frame numbers. Before
that occurs the frame numbers are displayed as "-1".

Therest of each displayed line/frame consists of either the recognized fixed group patterns or the
raw QPSK symbols. Each received 28 symbol group is compared to the fixed patterns. If the
group exactly matches a pattern, e.g. p0, p1, p2, €tc., then the pattern number is displayed.
Otherwise the 28 raw QPSK symbols are displayed. The four possible QPSK symbols are
trangated to printable characters for display. The trandation is given in the following table.

QPSK Symbol Phase Printed Character
(degrees)
0
90 +'
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180 '0'
270 !

Itislikely that two bits are encoded in each QPSK symbol using a Gray code. An arbitrary
alignment could have been chosen and the resulting bits displayed in the Rx Text window. Any
misalignment of the code would have been manifest in every bit or every other bit being inverted
from the correct sense. Patternsin the data bits might be evident despite the inversions, but
autocorrelations of the data so far have revealed no patterns. It was decided to ssmply display the
QPSK symbolsin order to reduce the volume of characters sent to the display.

3.5.10 NFM

The NFM is narrowband frequency modulation. NFM is similar but significantly narrower than
broadcast radio FM signals and television sound signals. NFM is used, abeit rarely, on HF.
Typicaly only narrowband FM is used on HF because of the limited total HF bandwidth available
and also because the main advantage of HF (i.e. over the horizon ionospheric propagation) is not
kind to wide signals. NFM is also used on VHF/UHF for public service (police, ambulance, fire,
etc.) communications. The public services have traditionally used NFM because typically only
voice quality communication has been required. Commercia broadcasters are also known to use
FM on HF for "studio links".

NFM can occasionally be heard in the 10m ham band around 29.6 MHz. On rare occasions studio
links originating in Texas can be heard in southern California around 25.99 MHz and 26.19 MHz.

NFM public service communications can be heard around 856 MHz, 860 MHz, and various other

frequencies.

An example of the appearance of an NFM signal in Sigmira's spectrum and waterfall displaysis
given in the figure immediately below.

T }I_II_III_II - | o I';-_"I_II_I:_II [ o o ‘I:—n oo ] I . IiI:II_II_I:_II o | " I'Iﬂ.l_il_lll_l_I o | et }I_II_III_II_II " i

et

s

NFM Signal
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The above display is from the included recorded example. It can be found at

<sigtools install_root>/examples/fm_090130_ 0012 864r052.wav
The recording is of police and ambulance calls at 864.052 MHz. Looking at the spectrum, the
central plateau with the "ears" on each end is no doubt from a Continuous Tone-Coded Squelch
System (CTCSS). The voice information isin the sidebands that extend further out from the
center.

Radio amateurs use a"deviation" of 5 kHz. The deviation isthe frequency difference of the
carrier from the nominal central frequency at the maximum DC modulation input to the
transmitter. The bandwidth of the modulating signal is limited to 3 kHz for amateurs. According
to Carson'srule the bandwidth of the transmitted signal is twice the sum of the deviation and
modulation bandwidth, or 16 kHz in this case.

Generally the Sigmira's Demod Width should be set to 10 kHz for NFM signals. (The Demod
Width is the nominal one sided IF width, so a setting of 10 kHz admits a double sided IF width of
20 kHz.)

(Note that the included example file was recorded at a sample rate too low to capture the full
width of the signal. Part of the upper sideband is cut off. It isstill usable as a demonstration.)

Sigmira uses the North American 75 s de-emphasis.

Set Sigmiras tuning frequency to the center of the signal. It isnot critical that the tuning be at the
exact center.

The sguelch control is aso functional in NFM mode. (See section 3.11, Squelch Control.)

3.6 DC Comp.

The DC Comp. feature adapts to the DC offset in the samples from the SDR-1Q4& .

|:| [z Comp.

Figure 15 - DC Comp. Button

Samples from the SDR-1Q&a have a DC offset that shows as a peak or faint line at the center of
the spectrum/waterfall. It can interfere with the demodulation of CW and phase modulated
signals. The offset varies with time and tuning.

In normal operation Sigmira subtracts an offset from each sample. That offset is a saved value
that isfixed when the 'DC Comp' feature is off. When the 'DC Comp' feature is turned on
Sigmira monitors the input samples and adapts the saved offset value to the current sample
stream.
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Normal usage would be to |eave the DC Comp feature off so that is not disturbed by actual
signals. If the DC offset becomes annoying tune to a quiet area of spectrum in the neighborhood
of the signals of interest. Turn the DC Comp on. The adaptation takes 5 or 10 seconds. The
results are observabl e in the spectrum/waterfall particularly at the narrow width settings. When
the central ridge is minimized turn DC Comp off.

3.7 Spectrum Controls

Speckrun
Widkh [] pause
O zkHz Srale

() G kHz (® 3548
) 10 kHz ) 60 de
() 25 kHz |Base

) sakHz +5dB
) 100 kHz Aubo
(%) 200 kHz -5dB

d

Figure 16 - Spectrum Controls

3.7.1 Spectrum Width

The Width buttons control the width of spectrum displayed in the spectrum and waterfall displays.
When the selected source is the SDR-1Q the full range of widths, 2 kHz to 200 kHz is available.
When the selected source is the sound card or awave file the maximum width availableis 10
kHz.

3.7.2 Spectrum Base

There are three buttons, "Auto", "+5 dB", and "-5 dB" that control the base level displayed in the
spectrum and waterfall displays. Level hererefersto how bright the noise floor appearsin the
waterfall display or how high or low the curveis drawn in the spectrum display. Adjusting the
display level is necessary because background noise levels vary considerably.

Pressing the Auto button causes Sigmirato examine the current signal and noise levels and adjust
the display level such that the noise floor is near dark in the waterfall display and near the bottom
of the spectrum display. Pressing the +5 dB button causes the display levels to shift up the
equivalent of 5dB. The -5 dB button causes the levels to shift down. Note that the signal level
scale in the spectrum display tracks the shifts so that the indicated levels remain calibrated.

The spectrum base can aso be adjusted by rolling the mouse wheel while the cursor isin the
spectrum display.
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3.7.3 Spectrum Scale

There are two buttons, "35 dB", and "60 dB" that control the scale of the spectrum and waterfall
displays. Scale hererefersto how bright asignal appears in the waterfall display or how high
above the noise floor it is drawn in the spectrum display. Adjusting the display scale is necessary
because absolute signal levels vary considerably.

At the smaller scale value smaller signals will be more prominently displayed. Note that the
signa level scale in the spectrum display tracks the scale adjustments so that the indicated levels
remain calibrated.

3.7.4 Spectrum Pause

The Pause button causes the spectrum and waterfall display to pause. Demodulation, audio
output, and all other functions continue.

3.8 Frequency

The Frequency indicator displays and controls the tuning frequency when operating with the
SDR-1Q.

[] Lock Center

Figure 17 - Frequency Control

The displayed frequency is the frequency pointed to by the red triangle in the waterfall frequency
scale. Positioning the PC mouse cursor over adigit and spinning the mouse wheel causes the
frequency to roll up or down in that digit position. Clicking on adigit in the frequency display
causes the tuning frequency to be rounded in that digit place. (i.e. clicking on the 5in adisplay
of 10.500000 causes the frequency to change to 11.000000.) Clicking on the triangle above a
digit causes the frequency to increment in that digit. Similarly, clicking on the triangle below a
digit causes a decrement.

As described in the section on the waterfall display, right-clicking in the waterfall display (or the
frequency scale, or the spectrum display) causes the tuning frequency to change to the frequency
of the point clicked. If the Lock Center box is not checked then the center of the displayed
spectrum range changes to that frequency. Consequently the red triangle will always be at the
center of the display.
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If the Lock Center box is checked then the center frequency of the displayed spectrum is fixed.
When the tuning frequency is changed the red triangle will move to the corresponding location in
the frequency scale. Thisis useful when the center frequency has been set to be within a group of
signals of interest. The tuning can be changed from signal to signal and the red triangle will
follow while the signals maintain their positions in the spectrum display.

3.9 Demodulation Width

The demodul ation width control adjusts the bandwidth used in demodulating the signal. Signals
vary inwidth. It is advantageous to adjust the demodulation width to be wide enough to include
the signal but no wider so that no extra noise is included.

Dermod Width
(*) 1 kHz

) 2.5 kHz
) 3kHz

() 5kHz
) 10 kHz

Figure 18 - Demod Width

The demodul ation width control is effective in the AM, USB, and LSB modes. AM and SSB
signals have considerable variability in width. In the other modes (particularly PSK31 and
RTTY) the signals have defined widths and the demodulators are tailored to those widths.

The selectable widths refer to the demodulated output. AM signals are double sideband. So the
transmitted width of an AM radio signal istwice that of the modulation. The transmitted radio
signal for AM with 5 kHz modulation will be 10 kHz wide as seen in the spectrum/waterfall
display. For such asignal the 5 kHz demodulation width would be appropriate. For SSB signals
the transmitted width is the same as the modul ation width.

AM broadcast signals have modulation bandwidth of 5 or 10 kHz typically. Ham SSB signals are
typically 2.5 to 3 kHz wide.

3.10 Strength Indicator

The Strength indicator is athermometer-like display that indicates the strength of the
demodulated signal.
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Squ

. L
Figure 19 - S-Meter

If the SDR-1Qa is selected as the source then the strength scale is similar to atraditional S-Meter.
Thetick marks are "S-Units" up to "S9" and then dB above S9 above that. (Only S5 and SO are
marked with digits to save clutter.) S9is-73 dBm or 50 mVrms at the antennainput.

If the sound card or .wav fileis selected as the source then the strength scale isrelative. (It is not
possible to accurately calibrate sound wave samplesto radio signal strength. Recorded .wav files
can have awide range of recording levels. And an external receiver connected to the sound input
typically has an AGC which resultsin arelatively constant audio level.) The strength scaleis
logarithmic. Full scale corresponds to the full strength representable by sound sample values.

Besides general curiosity, the Strength indicator is useful in adjusting the squelch (see section

3.11, Squelch Control) and setting up the optimum input level (see section 6, Conventional
Receiver Connection).

3.11 Squelch Control

The sguelch controls when the demodulation of the incoming signal is active. It setsaminimum
strength level that the signal must reach in order to be demodulated. Thisis useful in preventing
the background noise between transmissions from being interpreted as signal.

The squelch isadlider control that is controlled by clicking on it and sliding it up or down.

krength  Sguelch Wall

Figure 20
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The sguelch control is located next to the signal strength indicator and their levels correspond. 1f
the indicated signal strength is higher than the squelch the demodulation will be active. If the
squelch control is set to the bottom of its range the demodulation will always be active.

In CW mode the squelch control has a somewhat different function. In CW mode (Morse mode)
the squelch control can optionally be used to set the signal level that is considered as "key down".
When the signal level is above the squelch level it is considered a"key down™ period, i.e. part of a
'dit’ or a'dah’. When the signal level is below the squelch level it is consider to be a"key up”
interval, i.e. between a'dit’' or 'dah’. But it is not necessary that the best setting for this control be
selected manually. If the squelch level isset at O, at the bottom, the program automatically
adjuststo what it calculatesis the best level.

3.12 Mute

The Mute button controls whether the demodulated audio is played out to the PC sound output.

3.13 File Menu

The File menu isin the menu bar at the top of Sigmira'swindow. The File menu has two entries,
Open and Quit.

B SIGMIRA 110
Calibrate

Help
SpE

Source

Quit Chl+g

Figure 21 - File Menu

3.13.1 Open

Selecting Open brings up a dialog window that can be used to open an audio file. The file would
typically be previously recorded undemodulated signal as from the short-wave receiver output.
Once opened Sigmirawill play and demodulate the signal just asif it were live input.

Thefile can be a.wav format file with any normal sample rate from 8000 to 48000 Samples/sec.
Several example .wav files are included with Sigmira. They are useful in demonstrating
Sigmira's operation. See section 7, 'Wave File Input'.

3.14 Source Menu
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Sigmira can operate with input from three different signal sources. The source is selected with
the 'Source' menu at the top left of the main window.

le Calibrate
odi & SpR-IG

) Sound Card
£ W ave File

s

Figure 22 - Source Menu

3.14.1 SDR-IQa

If the SDR-1Q is connected operation will start immediately when selection is made.

3.14.2 Sound Card

Typically the sound card is used as the source when Sigmirais used with an external conventional
receiver. Thereceiver'saudio output is connected to the sound card input. See section 6 of this
document.

When the sound card is selected as the source the maximum width of the spectrum and waterfall

displaysis 10 kHz. The Sigmirafrequency controls do not control the tuning of the external
receiver. (That iscoming in afutureversion.)

3.14.3 Wave File

Playback begins when a .wav file is opened with the File->Open selection. (Opening awavefile
with File->Open also automatically sets the Source selection to Wave File.)

When 'Wave Fil€' is selected as the source the maximum width of the spectrum and waterfall
displaysis 10 kHz.

3.15 View Menu

Sigmira has several displayable sub-windows. They include the Signal Database, Phase Plane,
4285 Control, and Rx Text displays. They are described in sections 3.3 and 3.4. The View
menu can be used to cause these sub-windows to be viewable.
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Source

1 Signal Database
I Phase Plane
i | 34285 Control

Eve Digram L

Figurréhzdé - View Menu
3.16 Calibrate Menu

Under the top level "Calibrate" menu there is amenu item that alows for calibration of the SDR-
IQ crystal frequency.

B SIGMIRA 110
File

Source  MEE(EEN Help

Made y Speckrum
SDR-IC) Xkal Width
O am O s
(O Use O 1

Figure 24 - Calibrate Menu

3.16.1 SDR-IQa Xtal

The SDR-1Q& operates with a quartz crystal oscillator frequency standard. Crystal oscillators are
highly accurate but have some small frequency offset. That offset is evident with current
communications technology. Fortunately it is easy to compensate for the offset.

B SDR-IQ Xtal Calibration [

[ Indicated

l@ Tuning

|6080000.0 #ﬁf_ﬁ'ﬁé

[ Factory Default ]
I Cancel l I (0] 4 ]

Figure 25 - SDR-1Q Crystal Frequency Calibration
The SDR-I1Q Xtal Calibration window allows one to adjust Sigmirato cancel out the frequency

offset. When the window comes up both the 'Indicated Tuning' and 'Actual Tuning' are set to the
current indicated tuning. If either one is known to be incorrect the correct value can be entered.
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When the 'OK' button is clicked Sigmirawill adjust so that thereafter the indicated frequency will
match the actual .

As an example of how this can be done: One would tune to a known frequency standard such as
WWV. The higher the frequency the more accurate the calibration. Bring up the phase plane
display. (Seesection 3.4.) The signal should appear as adot or line segment radiating from the
center of the display. If Sigmiraistuned exactly to the carrier frequency the dot/line will be
stationary and not revolve around the center. If the signal is higher in frequency the dot/line will
revolve around the center counter-clockwise. Adjust the tuning frequency so that the dot/line
motion is the minimum possible. At this point the actual frequency will be most correct. Bring
up the calibration window. Correct the displayed 'Actua Tuning' to be the known correct
frequency of the reference signal and click 'OK'. (Note that the best practically achievable
accuracy is about 0.5 Hz and that the crystal reference in the SDR-I1Q can easily drift several Hz
in an hour.)

The 'Factory Default' button allows the calibration to be reset to the original nominal value.

4 Signal Database

The Signal Database allows one to log, categorize, recal, and instantly tune to signals. The
number of entriesisunlimited. A database already containing over athousand entriesis included
in the Sigmira package.

The Signal Database is brought up by clicking the menu View=>Signal Database in the Sigmira
main window. The Signal Database will appear as shown in Figure 26, below.

M Sional Database E|E|g|
File
M Find
Frequency ¥  Mode 4 | Description 1 Catl 4 Cak2 4 Parameters 4 |
5.730002 usbh - beqin fixed and non-aero maobile band fixed
5.733000 ush mixed baqg, mfsk wscrm 090113_0726 utc 2326 Icl curious
5. 745000 am broadcast, sp, 8 081225_2108 broadcast
5. 750002 am - begin a broadcast band? broadcast
5.755000 an broadcast, strong, 050919_2332 broadcast
5. 765000 a broadcast, strong, religious 050919_2332 hatefull 061110_2240 broadcast
5.764000 Fsk. fsk, s3 070210_0755 unkn
£ 00000 i Bg??;;ig?s(md morse code), probably Cuba, nightly 0630UTC, s94+10 are
5.807000 jsm "slat machine” reported maritime
5.509000 ush carrier, s9+15 gshb 070210_0800 urikn urikn
5.810000 am broadcast, jp?, s8 081 226_0810 broadcast
5.535000 an music, s6 070210_0800 broadcast woice
5.850000 an broadcast strong religious 050919_2332 broadcast
5.860000 am broadcast, middle eastern?, s5 081226_0810 broadcast
£ R3000 it Etn;l;e:f,ﬂstgEI;illdl's,_zgiz‘c:,lclﬂSD‘%2?_232? Icl, s9 081227_2329 Icl, 59 090102_2337 are 3
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Figure 26 - Signal Database

Each signal entry in the database is one row. Right-clicking on arow tunes Sigmirato the
frequency shown in Frequency field for the selected entry. The right-click also setsthe
demodulation mode according to the Mode field.

4.1 Sorting

Each entry has six fields: Frequency, Mode, Description, Catl, Cat2, and Parameters. The six
fields make up the six columns of the view. Left-clicking on the heading of a column causes the
database view to be sorted based on that field. Clicking a column heading the first time causes an
ascending sort. Clicking a second time causes a descending sort. If asignal entry is already
selected when a sort is performed then that signal entry will be scrolled to the center of the view.

4.2 Editing

All of the fields of an entry are editable. Left-click on afield twicein order to edit it. Note that
edits made are not saved to disk until Save or Save Asis clicked in the Signal Database window
File menu.

4.3 Fields

The Frequency fieldisin MHz. Whenever a new database entry is created Sigmira automatically
enters the currently tuned frequency.

The Mode field corresponds with the demodulation modes in the upper left of the Sigmiramain
window. The Modefield is not case sensitive. "am"”, "AM", "aM", and "Am" are all equivalent.
If the content of the Mode field doesn't correspond with one of Sigmira's recognized modes
Sigmiradefaultsto USB. Whenever a new database entry is created Sigmira automatically enters
the currently selected mode.

The Description field is available for any descriptive information the user would like to associate
with the signal. Whenever a new database entry is created Sigmira automatically enters the string
"new" plusthe current date and time. This may of course be edited.

The Catl and Cat2 fields offers a means to place signals in user defined sortable categories.
Clicking on the head of the Cat1 or Cat2 column will sort the database based on the contents of
that field. Soif al of the "numbers’ station signal entries have the string "numbers’ in the Catl
field then sorting on the Cat1 column will display the numbers stations grouped together.

The contents of the Cat1 field are also interpreted to give a background tint to each entry. Ten
predefined values for the Catl field are recognized. The values and the associated colors are
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given in the table below. The categories correspond roughly with the categoriesin the US
Frequency Allocation Chart, http://www.ntia.doc.gov/osmhome/ChpO4Chart.pdf .

Catlfield value | Tint

av light blue
broadcast yellow
cb light yellow
curious pink
fixed brown
ham green
maritime blue
misc gray
numbers red

ref light gray

The Parameters field provides a means to associate additional demodulation parameters with a
signal. The Parametersfield will be fully implemented in afuture version of Sigmira. The
parameters can include things such as bit rate and interleave for STANAG 4285 signals or shift
and baud rate for FSK signals, etc.

4.4 Buttons

Clicking the Find button in the upper right portion of the Signal Database window causes the
entry in the database closest in frequency to the current main tuning to be scrolled to the center of
the database window and highlighted.

Clicking the Delete button in the upper center portion of the Signal Database window causes the
current selected entry to be del eted.

Clicking the New button in the upper left portion of the Signal Database window causes a new
entry to be created. The Frequency field of the new entry is automatically filled in with the
current tuning frequency as shown in the Sigmira's main window. The Modefield is
automatically filled in with the current mode. The Description field isfilled in with the string
"new" plus the current date and time.

4.5 Signal Database File Menu

In the menu bar at the top of the Signal Database window is a File menu. The File menu has four
entries, Open, Read, Save and Save As.

Selecting File=>Open brings up adialog window that can be used to open a signal database file.
At startup Sigmira automatically opens the signal database file "sigmira.sdb”. Using the Open
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dialog adifferent file can be opened. The contents of the newly specified file become the
operating signal database. The newly specified file name also becomes the default for the Save
function.

Selecting File=>Read brings up a dialog window that can be used to read in an additional signal
database content from afile. The contents of the file are added to the current operating signal
database. The file name specified in the Read operation does not change the default file name for
Open and Save operations.

The signal database can be saved to disk by following the File=>Save or File=>Save As menu
dialogs in the Signal Database window. The Save operation saves the signal database to the
default signal database file name. The default file name at start-up is"sigmira.sdb”. With the
Save As operation the database is saved to a newly specified file. The newly specified file name
becomes the default file name. Subsequent 'Save' selections will write to the remembered
destination file name. Any save to afile overwrites the previous contentsif any.

On exit Sigmira backs up the current database contents to the file "sigmira_bu.sdb" regardless of
other operations.

5 SDR-IQ& Operation

Connect the SDR-1Q4& to the computer with the USB (Universal Serial Busin this case) cable.
Connect an antennato the SDR-1Qa . Start Sigmiraand select the SDR-1Qa as the signal source
viathe 'Source’ menu at the top left of the window.

6 Conventional Receiver Connection

Sigmira can operate with a conventional short-wave receiver. The receiver must have and must be
operated in the Single Sideband (SSB) mode. Upper Sideband (USB) mode is preferable.

Connect the audio output of a short-wave receiver to the audio "Line In" audio input of the PC.

If you are fortunate your receiver will have an output that is before the volume control. In that
case the PC receives a good constant level signal regardless of the receiver's volume control
setting. On some receivers such an output is labeled AFSK Out. Otherwise you can tap the
speaker output, set the volume for a moderate level, and avoid making changes to the level.

Adjust the gain and volume controls so that the signal isn't so strong that it becomes clipped or
distorted. The controls on the receiver and also the PC's Recording Control window can be use to
make adjustments. The PC sound controls can be accessed by clicking start=>run... and typing
"sndvol 32" or they can be accessed through the control panel by clicking start=>Control
Panel=>Sound and Audio Devices=>Audio=>Volume. The resulting window will likely look
like:
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B Master Volume

Options  Help
Master Volume Wave S Spnth Aux Video CD Audio Line In Microphone Fhone Line
Balance: Balance: Balance: Balance: Balance: Balance: Balance: Balance: Balance:
P09 63 90T 9p-3 90— 9T 96— 4>— 46— ¢
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Figure 27

(Itisagood ideato mute the "Line In" in the Master VVolume window.)
Then the "Line In" input needs to be selected in the Recording Control.

To get to the Recording Control window select Options=>Properties=>Recording. Y ou should
get awindow like:

il Recording Control
Cptions  Help

Stereo hix AL Yideo CD Audio Line In Microphone
Balance: Balance: Balance: Balance: Balance: Balance:
49— 9| 4P DB &P

Yolume; Yalume; Yalume; Yolume; “olume: Yalume:

: |
et L Lo L.l

|

[]5elect []5elect []5elect []5elect Select []5elect

5i53 7012 Wave

Figure 28
Click the Select box under Line In and then adjust the Volume slider.
The optimum volume level setting is obtained when even the strongest input does not " peg"
Sigmiras Strength indicator. Start Sigmira, select "Sound Card" source, and select the AM mode.

Tunein astrong signal (of any type) on the receiver. Observe the Sigmira Strength indicator and
adjust the volume so that the strength indicator never goesto full scale.
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7 Wave file Input

Sigmira can operate on prerecorded .wav files without an external receiver connected. Start the
program and from the top menus select: File=> Open. To find the example filesfirst click on the

"Sigtools' button:

May 3, 2009

B SIGMIRA
File

B Open Wave File

Viewy  Source

Calibrate

Help

The "examples' directory will then appear. Double-click on it:
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Figure 30
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B Open Wave File

E aaa (| apps || sigtools_1r2

Places Marme * | Modified
[ harlow = bin Yesterday
D Desktop P doc Monday
& an B ete 4112008
B @ examples 4/11/2008
& on B b k 4112008
@& en B share 4112008
E Fil — D readme_sigtoals_1rZ, kxt 462008
& e o |3 uninstall.exe 4112008

Zancel l ’ CIpEn

Figure 31

Then select the RTTY example file by double-clicking onit:

B Open Wave File

a3a |

@ [

apps || sigtools_1r2 || examples
Flaces Marme * | Modified
D harlow D am_7Fr355 070611 _0710.wav &/12/2007
[ Deskiop [ am_7r375_070611_0645, way &6f12/2007
B an [ cw_070114_0631 . war 1/20/2007
B o [ pskfest_070113_1130.mav 1f20/2007
& oy
B ey
E F:i, L
& sy

| £

Cancel ] ’ CIpEn

Figure 32
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The example file will then start playing. Click onthe"Lock Center" button. Click on the
Spectrum Width 5 kHz button. Right-click on the 1070 mark on the waterfall frequency scale.

The display will look something like:

H SIGMIRA
Eile ‘jew Source Calibrate Help
Mode Spectrum
widkh |:|
{L] pause [] Lack &
© Ant O 2kHe |-Scale
O e (3) 5 kHz Oxde| . . . ..
O LsE O 10kHz | @) e0de
|:| D Comp. e
) Pkl () 25kHz Base - 00 000
@ RITY O 50 kHz ST
O cw O 100 kHz
O v
[dE)

Click onthe RTTY mode 'radio button':
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Figure 33
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B SIGMIRA 110

File Source Calibrate Help
Mode Spectrunm
Width
O am ) skHz  |[] pause
O usB ) 10kHz
{::' L5E I:l DiZ Comp, O 25 kHz
i Pskal () E0kHz | :
RTTY () 100 kHz &

(B}

Figure 34

The demodul ated message will then start to appear:

| 3 I_I LI | | | |

S[(=1

File  Edit
A UFS AMNOUNCEMENT WOULD

MOT SURPRISE ME A5 THE PUEBL

HAS HAID FIFTY SOME YEARS T MEMTALLY

PREPARE ‘WHrM

Figure - 35
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8 Program Installation Details

On some machines Sigtools may not install correctly on thefirst install. In that case there are two
visible symptoms. Oneisthat at installation time a pop-up will appear asking if a.bat script
should be allowed to run. The other isthat when Sigmirais started after installation its lettering
appears as sguares rather than letters.

The cause is that the PC's particular security settings blocked a .bat script that the installer uses. It
should be allowed to run. The script is necessary and it is not harmful. (The script remains under
the installation directory and can be examined.)

Unfortunately allowing the script to run doesn't always work on the first install. It does work on
the second install. The reliable solution if the problem occursisto alow the script on the first
install, uninstall, and then install again.

The following problem should be eliminated as of Sigmira 1r3:
After first installation on some systems Sigmira complains that it can't find ftd2xx.dll.
ftd2xx.dll isthe USB driver dynamically linked library from Future Technology Devices
International, Ltd. The easiest solution isto copy the file <sigtoolsinstall
root>\drivers\i386\ftd2xx.dll (<sigtoolsinstall root>\drivers\amd64\ftd2xx64.dll if you are on
a 64 bit machine) to the directory c:\WINDOWS\system32

9 Credits

Sigmirad is Copyright 2009 by Steven A. Harlow. All rights reserved.
http://www.saharlow.com/technology/sigmira

Sigmirad isatrademark of Steven A. Harlow.

SDR-1Q& and SDR-144 are trademarks of RFSpace, Inc.  http://www.rfspace.com/Home.htmi

Sigmirauses GTK, GDK, Pango, Cairo and OpenGL, which are licensed under the GNU L esser

General Public License (LGPL).  http://www.gtk.org  http://www.pango.org  http://cairographics.org
http://www.opengl.org

Sigmira uses USB drivers from Future Technology Devices International, Ltd. [FTDI].
http://www.ftdichip.com/Drivers/\VV CP.htm
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